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ESITTELY

Expresii on uusi maalausohjelma joka tuo itdmaisen mustemaalaamisen orgaanisen viehkouden digitaaliseen

ympadristoon. Se vie eteenpain saman kehittdjan 2005 esitteleman MoXi jarjestelman ideaa ja visiota.

Laitteistosuositus
Expresii hyodyntda GPU:ta (Graphics Processing Unit) eli grafiikkaprosessoria kiihdytettyyn prosessointiin.

Taman padivan koneiden GPU:t vaihtelevat paljon suorituskyvyltdan. Suosittelemme vahintadn alemman
keskitason (~100€) GPU:ta sujuvaan (150+ FPS1) Expresiin kdyttoon. Suosittelemme myos etta kaytat

kallistusta tukevaa piirtokynaa. Lisatietoja l0ydat nettisivujemme FAQ (YKK)-osiosta.

FPS eli RPS tarkoittaa Frames Per Second/Ruutua per sekunti. Simulaatio RPS naytetain pasgikkunan otsikkorivilla.

Kayttoymparisto

Expresiin Tyokaluikkuna nayttaa vaihtoehdot jaettuna viiteen vililehteen: Paperimateriaali, Paperioperaatio,

Sivellin, Lataus ja Ohjelmavalikko.

Paaikkuna
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Kieli Voit vaihtaa Kayttoliittyman kielen kohdasta App Menu 5 ¥ System

almaalol = | o lo] v Lo

Ohjelmavalikko>Jarjestelma>Kayttoliittyma 5 s

5 View g |English -

» Windows

English
> e 'V cam—
2 System e (&
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Koko naytto. Paaset koko nayton tilaan pikanappaimelld [F11] tai

Ohjelmavalikko>Nayta>Koko naytto App Menu @@
1 I .I —l

Automaattinen ylosvieritys. Tyokaluikkuna rullautuu ylos oletuksena jos se on Padikkunan kanssa
paallekkain. Jos et halua sen kutistuvan, vaihtele tatd ominaisuutta painamalla otsikkorivin

Pienenni/Suurenna painiketta.

¥ System
. : o N [bla] v 5]
Siveltimen ulkoasu. Voit - .. By
vaihtaa siveltimen -V @

Brush Details: Lowi

ulkoasun kokonaisesta
siveltimestd pieneen
pisteeseen tai taysin

nakymattomaksi.

Vihjeet ja ohje. Vie hiiri kayttoliittyman kohteiden paalle nahdaksesi niiden vihjeet. Jos kohteella on

pikandppain, ndytetdan se ulkeissa. Napsauta [F1] ndahdaksesi listan pikandppaimista ja taman kayttéohjeen.

SIVELLINVEDOT

Expresii on suunniteltu piirtokynaa ajatellen ja etupaassa itamaisen piirtojaljen/siveltimen vetojen

jaljentamista ajatellen.

Kynan kallistus

Virtuaalisen siveltimen taysi hyddyntaminen onnistuu kynalla, joka kayttaa seka paineentunnistusta, etta

kallistusta. Mikdan muu ohjelma ei pysty ndayttdmaan siveltimen vaantymistd maalatessa siten ettd nakisit



samalla jéljen jonka se tekee.

Jos kynasi ei tue kallistusta, kayta hiiren oikeaa ja vetamista vaihtaaksesi siveltimen kulmaa. Voit myos

kayttda Android laitetta kallistuksen kontrollointiin. Lue lisda Extra laitetuki osiosta.

[ ¥ Deposition |

: / @g—tr{
Naarmuisuus S et A

Naarmut nakyvat kun sivellin on tarpeeksi kuiva. (Markyystaso alle 6)
Myds nopeampi veto tai alhaisempi paine lisda naarmuisuutta. Kayta

pikandappaimia [A] [S] saatadksesi kuinka helposti naarmuisuutta ilmenee.

L]

Mc Streakiness: 0.5

Viiruisuus

Viiruisuus saatelee onko naarmuisuus enemman raidallista vai rakeista.
Eron huomaa selvimmin jos teet siveltimenvedot siveltimen sivulla etka

karjella.



Siveltimen esiasetukset

Nykyisellddn esiasetuksia on kaksi: Juoksutus ja Neula. Juoksutus vaantyy kuten itdinen sivellin, kun taas

Neula on muuntumaton ja ohuempi. Juoksutuksella saat enemman vaihtelua ja Neulalla tarkkuutta. Vaihtelet

nopeasti siveltimien valilla kayttamalla pikandppdainta [B] tai Padikkunan Sivellin-kuvakkeella.

Piirtoapu

Geometrista apua voi kdyttaa suorien
viivojen ja ympyroiden piirtdmisen. Ota se
kayttéon Ohjelmavalikon
Natt6>Geometrinen piirtoapu
painikkeen kautta. Kun paalla, paina
[Vaihto] rajoittaaksesi vetosi apuviivan
mukaisesti. Ympyra-apuviiva auttaa
piirtamaan ympyroita pitamalla
siveltimen alhaalla ja painamalla kddnnon
pikanappaimia [PgUp], [PgDn]). Helpointa

on jos katsot video demo n toiminnosta.

L9 =B

Actions

View

ok
Geometric Drawing Aid
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Tata monimutkaisempiin geometrisiin muotoihin kannattaa kokeilla lisdosaa Lazy Nezumi Pro, se toimii myos

Expresiissa!

LATAAMINEN

Expresiin erottaa muista ohjelmista erityisesti se, ettd maalaat
liukuvarilla, etka yksittaisella varilla. Varien lisaksi lataaminen sisaltaa

myos veden tason.

Varien lataaminen

Ladataksesi vareja, upota sivellin variviuhkoihin. Mitd kovemmin painat
sen enemman vari uppoaa siveltimen "sisaan". Erilaisilla paineen
tasoilla voit luoda erilaisia liukuja. Nykyinen lataus nakyy palkissa, jonka
oikealla on roskakorin kuvake. Kun haluat luoda uuden latauksen
esiasetuksen napsauta Esiasetuksen valitsimen oikealla olevaa ikonia ja
valitse "Lisda". Se kopioi nykyisen Esiasetuksen uudeksi. Voit nyt kayttaa
tata uutta asetusta omiin kokeiluihisi. Jos haluat palata alkuperaisiin
esiasetuksiin voit resetoida valitsemalla Esiasetukset-valikosta ”"Koko

setti"> Tehdasasetukset.

Pikavalinta. Heti Esiasetuksien pudotusvalikon alla on Pikavalinta-
paneeli joka ndyttda esiasetusten listan. Voit vaihtaa 10:nen
ensimmaisen valilla nopeasti pikandappaimilla [0]-[9]. Ja vaihtaa niiden

jarjestysta pudota-raahaa tekniikalla.

Pika variaatiot. Nykyisestd latauksesta on nopea tapa saada vaaleampi
tai tummempi versio: raahaa ylempaa palkkia ylos tai alas (pikanapp. [,]

[.]). Resetoidaksesi napsauta alempaa palkkia [/]). Voit my6s napsauttaa

oikealla painikkeella alempaa palkkia ja valita 'Kdanna' kadntaksesi liu'un.
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[ = Purple & Violet
[ ] Tropical Fish
4 E Rubber Duck -
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r Color Gradient to be mapped onto the Brush.

Drag up and down to adjust lightness.
(Hotkey:, . Reset: /)

Veden tasot

Ved3 vesipisaraikonia yl6s/alas sdatasksesi veden maaraa. Vaihtoehtoisesti
voit painaa paperiliinan ja vesisailion kuvakkeita sen molemmin puolin
laskeaksesi ja nostaaksesi veden tasoa. Tai kdyttda pikandappaimia [Q] ja

(W]

Pipetti

Napsauta [Alt] vaihtaaksesi nopeasti Pipetti tilaan jos sinun taytyy valita vari,
joka on jo maalattu paperille. Vaihtoehtoisesti voit napsauttaa Pipetin ikonia
lataa valilehdelld. Naytteistaminen on paineentunnistavaa. Naytteenotolle on

pari asetusta:

Puoliviliin. Jokainen veto poimii varia vain puoleenvaliin. (Pikandppain:

+[Ctrl]). Katevaa jos haluat luoda transitioita.

Vain referenssikuva. Tama vaihtoehto tutkii vain yla-ja alatasoja
naytteenottoa varten. (Pikandppain: +[Vaihto]). Hyodyllista jos tarvitsee
maalata esim. tausta, missa kaytat referenssikuvaa ladattuna alatasolle.
Varia jonka ndytteistat voidaan kdyttdaa markana musteena. Nain ollen,
vaikkakin vari on poimittu referenssista, sisaltaa luomasi kuva
hienovaraista musteen hajontaa, joka taas antaa tyodllesi orgaanisen

tunnun.
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Move Cursor in the Main
Window to Sample Color
(Hotkey: Alt)




SIVELLINTILAT

Brush ="l
9 | >4 (=
H Preset I <= W Flow v‘
Pyyheku m I > Shape & Size
Tarkea tydkalu. Naarmuisuuden rinnalla kdytettyna se on hyddyllinen savyjen = e
saadossa ja tekstuurin lisadmisessa maalatulle alueelle. Vaihdat siihen nopeasti » Deposition
pikandppaimella [E]. Kayta [Q] ja [W] saatdadksesi pyyhekumin voimakkuutta. 2 Mode
€ U N @
V . k.. k- . k
a I n a r I > Pressing  pigment -/+ (G)
I

Vain siveltimen karkea kdytetdadn. Tama helpottaa ohuiden viivojen piirtamista.
Ruisku

Sivellin muunnetaan ruiskuksi. Kokoonmeneva paneeli ilmestyy ja ndyttaa erilaiset ruiskutus saadot, kuten

sateen ja tiheyden. Pyyhekumitilaa voidaan kayttda yhdessa ruiskutilan kanssa.
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Pigmentin maaran saataja
Tilaa kdytetaan vaalentamaan tai tummentamaan paperille jo maalattua maalia. Vaihtele

vaalenna/tummenna tilojen vililld napsauttamalla ‘Pigmentti -/+" kuvaketta tai pikandppaimella [G]. Vihje:

Voit nopeasti kiertda kohdealueen paalla kuten kiillottaessa saadaksesi tasaisia siirtymia.

MARKA MAAL]

Kun siveltimesi on tarpeeksi marka (Markyysaste >6) huomaat, ettd muste paperilla alkaa levita. Lisaa
mustetta tai kosteutta ja saat vielda enemman hajontaa. Voit myds kostuttaa paperin ensin 'vain-vetta’-

siveltimelld ja lisata mustetta sen jalkeen marille alueille saadaksesi pehmeat reunat.




Kuivaus. Napsauta pikanappainta [D] kerran kuivataksesi paperia System Setings [=a

hieman. Kaksoisnapsauta kuivataksesi kokonaan. Huomaa, ett3 [ General [, | adhonced | gives | LK
Simulation FPS limit

Zoomed-out quality ¥ Auto

kuivauksenkaan jalkeen maali ei ole lopullisesti kuivaa, vaan

uudelleen kastelu saa sen taas virtaamaan. Jos haluat suojata it L L L ey
(@ save power on idle
maalisi, aseta se ei-aktiiviselle tasolle. Teemme uusien tasojen 7 Mouse buttons fipped

lisdamisen mahdolliseksi myéhemmin. Oletuksena musteen

virtaus keskeytyy kun Expresii on toimettomassa tilassa, eli

kadyttaja ei tee mitdan hetkeen. Tama sadstaa virtaa ja pitdd koneen viiledna (tarpeen esim tableteilla). Jos
sinulla ei kuitenkaan ole mitdan virran kuluttamista vastaan ja haluat jatkaa virtauksen simuloimista, voit
menna Ohjelmavalikko>Jarjestelmda>Enemman vaihtoehtoja avataksesi Jarjestelmdasetukset-ikkunan. Siella

Lisdasetuksissa ota rasti pois kohdasta ”Sadsta virtaa lepotilassa”.

Kerrostuman sekoitus. l | . 12 |

. . . [—— \J
Juuri maalattu maali voidaan - T m—
asettaa korvaamaan véri tai r‘ (] ' ‘

tummentamaan aiemmin

maalattu maali kayttdmalla kerrostuman sekoitus saadinta [New deposit) [New deposit]
[Qarkens)

Lataa-valilehdellad SGada kohdassa. Katso video Demo Video:

Deposition Blend sen toiminnasta.

Kuvioitu vrs tasainen. Expresiissd marat jaljet voivat olla joko kuvioituja tai tasaisia. Saat jalkiin tekstuuria kun

markyystaso on riittdva (>6) ja muste alkaa virrata.


https://youtu.be/LBV_EwkqHYw
https://youtu.be/LBV_EwkqHYw

Juoksutukset

Juoksutus ja pyyhekumi. Joskus on hyva antaa musteen virrata vapaasti isolla alueella ja pyyhkia jalkeenpain

pois ne kohdat, joita et halua. Demo video: Flow Man.

Voit myds
kayttas
pyyhekumia
matalalla

voimakkuudell

a (Saadi | T

pikanappaimill
a [Q] [W]) luodaksesi negatiivista naarmuisuutta ja saada siten tekstuuria aikaiseksi. Pyyhitty aluekin

pysayttad musteen virtauksen, joten sitd voi kdyttaa suoraan siihenkin. Demo video: Thunder Cat.

Suunnittele juoksutus. Suunnittele juoksutuksesi siveltimesi liukuvarilla luodaksesi kiinnostavia kuvioita. Esim.

Thunder Cat demo ssa maalasimme siveltimen kadrkeen ladatulla siniselld musteella useita kertoja

luodaksemme jaljen jolla saimme aikaan vaikutelman kissan turkista.

Muut saatimet. Voit lisdta vettd jo markaan alueeseen napsauttamalla Moisture / Tilt

‘lisaa kosteutta’ ikonia tai pikandppaimella [Y] saadaksesi musteen taas = 1=) I I

virtaamaan. Muut saatimet |6ytyvat ‘Kosteus / Kallistus paneelin |Add maisture to wetted area (Y)

vasemmalta puolelta: il u “

1. Na&ytd marka alue: Markéa alue merkitty ruudukolla.

2. Lukitse maran alueen laajennus: Lukitse maran alueen raja. Hyoédyllinen kun haluat rajoittaa
virtauksen tietylle alueelle. Voit maarittda taman alueen esikastelemalla sen ’vain-vettd’ siveltimella.

Voit luoda maran alueen myds pyyhekumilla.


https://youtu.be/6nrWj2gXmNY
https://youtu.be/oIk6dkZSKtY
https://youtu.be/oIk6dkZSKtY

3. Jaadyta juoksutus: Keskeytd juoksutus (pikandppdin [F]) kun saat kivan kuvion aikaan musteen viela

juostessa. Vesi on sielld yha ja juoksutus jatkuu kun palaat. Jos haluat lopettaa juoksutuksen

kokonaan, kayta ‘Kuivaa’ toimintoa (kaksoisnaps [D]).

PAPERITOIMINNOT

Koon muutos

Voit muuttaa paperin koon Paper Operation =1 El =~
. . - 5 T Width bi-g Height 7 -? units Lo |
napsauttamalla Rajaa ikonia R d |V |= & = x|
> o o
kohdasta Paperitoiminnot> ¥ Format
Muoto. Expresiissa preset | [ [Custom] | -
1 =
mittayksikkéna on yksikot
5x6
pikseleiden sijaan. units
1
Kaannds ja peilikuvaksi kaantaminen
Ikkuna>Paperitoiminnot>Muokkaa kohdassa voit:
Kidnnés. Voit uudellen asemoida teoksesi paperilla vaihtamalla Kagnnos- | FaPsr Opsration (=] &
tilaan. Napsauta Kdaannds-ikonia ja raahaa hiirella tai kynalla. Paaset w N J/ ot | =
1
Kdannos-tilaan myos [Vaihto] nappaimella. » Format
» Moisture / Tilt
¥ Edit

Peilikuva. Talla hetkelld tuemme vain vaakasuunnassa peilikuvaksi
kaantamista, silla taiteilijat tarkistavat usein sen avulla onko hahmo
oikein piirretty, seka kayttavat sitd jos hahmo on helpompi piirtda toisesta

suunnasta.

$ A

Translate [Shift+drag)k

Nama toiminnot tapahtuvat oletuksena kaikille tasoille. Jos haluat asettaa toiminnon vain aktiiviselle tasolle,

ota “Kaikki tasot” ikoni pois pdaltd Muokkaa-paneelissa.




Pinnan kallistus

Expresii tukee maalauksen pinnan kallistusta jotta maali virtaa kallistuksen suuntaan. Kallistuksen voi tehda

usealla tavalla:

Ul eli kayttoliittyma. Paperitoiminnot-ikkuna>Kosteus / Kallistus ja

veda pintaa paneelin keskella. Kulma palautuu kun napsautat kuvaketta

vetamatta.

G-Sensori. Suurin osa moderneista
tableteista on varustettu G-
Sensorilla, joka aistii tabletin
suunnan. Saatat valmistajasta
riippuen joutua vaihtamaan x-y
akselit tai kddantamaan ne kohdasta
Ohjelmavalikko > Sy6tt6> Pinnan

kallistus> ikonit.

«

b

b

b

b

0o

Moisture / Tilt

Ch

L't

[¢'
A
Mo Controller
Controller Stick
Controller Tilt
Droidmote

G-Sensar [}‘

Paper Operation =1 B
I | I ———
o alels
» Format
¥ Moisture / Tilt
S5 &
(8] i &
[ )
Drag to Tilt
» Click to Reset
App Menu =n u
S O =
» Actions
» View
» Windows
¥ Input
o O ¢ =
._D G-Sensor v
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Huomioi, ettd kun kallistuksen hallinnan valineet on valittu, pienen ikonin napsauttaminen hiiren vasemmalla

uudestaan vaihtaa vain 'paalla/pois paalta’-tilaa. Valitaksesi uuden laitteen napsauta ikonia hiiren oikealla.

TASOT

Expresii tukee toistaiseksi vain kahta maalaustasoa. Ylempi taso on aina
aktiivinen. Voit vaihtaa tasoa pikandppaimella [L]. Maalaustasojen lisaksi

on pari aputasoa kompositioiden tekoa varten tai lapipiirtdmisen avuksi.

Lopulliseen kuvaan vaikuttaa mika tasojarjestys sinulla on.

Overlay-taso=Paallystaso, sen alla kaksi punaista Maalaustasoa, joista

ylempi aktiivinen. Niiden alla Underlay-taso eli Alataso ja alimpana Base

Color-taso eli Pohjavaritaso.

Paintihayers

\ AN
\ nderlay

Nase Colo\




Kun maalaustasoja on vain kaksi, on usein hyva maalata toiselle isommat maalialueet ja toiselle viivat:

—
ST
preset O fComom] @] 1 Preset [ [Custom) D=
= 5 &l
- ———
o]
% I.f;' @
El
~ K =& B
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Paper Operation
Voit ladata linkista ylla olevan tyon ja tutkia sitd: ‘Monkey Kin s_':j [ / J =
. . . b3 Format
Yhdistaminen —
» Moisture / Tilt
Tasoja voi yhdistaa kahdella tavalla: 2 Edit
» Cverlay
[l
. . Pag | | ¥ Layers
Yhdista m
Yhdista painikkeen painaminen yhdistaa ylimman tason alimpaan tasoon. o Bl
’ \4
Kun maalitasot yhdistetaan nain menetetaan uloimpien reunojen 3 g d Q
- 4 M
teravyys kohdissa joissa jaljet ovat paallekkain. Kayta tata tapaa kun 3 m 2 s
= = F,
kahden tason jdljet eivat ristea. i Overlay
» Layers
¥ Underlay
Naps-alas [Masmoon] [ o
Napsaus siirtda tason alas ja yhdistda siirretyn tason Alatasoon. Sen nimi | Shift paint layers and merge down to Underlay (V)
on Naps-alas koska se napsaisee kuvan siirretystd tasosta ja yhdistaa sen

alatasoon. Alataso toimii rasteritasona (kuten perinteisissa bittikartta pohjaisissa kuvankasittelyohjelmissa)

Menetat siis ultrazoomaus kyvyn kun maalitaso rasteroidaan alatasoon.




Interaktio

Talla hetkelld taso voi toimia toisen tason
kanssa vain yhdella tavalla: tahraamalla.
Voit sdataa 'Tahra alemmalta tasolta’
liukusaatimella kuinka paljon ylempi,

aktiivinen taso poimii mustetta alatasolta

kun kastelet ylempaa tasoa. Veda aivan
vasemmalle, jos et halua minkdanlaista

interaktiota tasojen vilille.
TEOS TIEDOSTOT

Kun tallennat teoksen, syntyy kaksi tiedostoa: .XAW ja .JPG. (XAW =
eXpresii ArtWork) on varsinainen teostieto-tiedosto ja .JPG ldhinn3
esikatselutiedosto. Esikatselutiedoston koko mahtuu oletuksena 1440
pikseliin ja tatd voi muuttaa Asetukset-valilehdelld. Kun Expresiistd ladataan
esikatselutiedosto, aukeaa varsinainen teostiedosto (jata .jpg:n nimeksi

sama kuin .xaw-tiedostolla)

TUO

Koska Expresii teokset tarvitsevat enemman informaatiota kuin vain pikselit
toimiakseen, ei ohjelmassa ole varsinaista Tuo-toimintoa. Voit kuitenkin tuoda
kuvan Ala-tai Padllystasona, jonka jdlkeen voit kayttaa niita referenssikuvana

tai tavallisena rasteritasona.

Ladataksesi kuvan Ala-tai Paallystasolle, napsauta Ul Paperitoiminnoissa ja
Paallystaso tai Alataso. Voit myds raahata kuvan (.jpg tai .png) Paaikkunaan

jolloin ohjelma kysyy haluatko ladata sen P&allys-vai Alatasona.
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Click to load




Kolmas tapa on liittda kuva kayttojarjestelman leikepoydalta. [Ctrl]+[V] [1mege imprt

u W Overlay

J

= Underlay

Size Limit
[[IDon't ask again

VIE

Viennin voi tehda kahdella eri tavalla:

|
3840 x 4,608 (pixels) M save. I

1. Vedos: Ohjelmavalikko>Toiminnot>Vie-kuvake.
Vedoksia voi tallentaa alfakanavan kanssa ja kayttaa
toisten kuvankasittelyohjelmien kanssa. Tuetut muodot
ovat .BMP, .PNG, TIFF, ja .PSD. Photoshopin .PSD
muodossa voit vieda tasoja. (Saatat joutua asettamaan
maalitason sekoitustilaksi ‘kertova’ jotta saat Expresiin

tyylin toistumaan).

‘ ’ . .. . .
Korkea laatu’ asetusta tarvitaan ldhinna kooltaan || oapmacrmel  [@Hcrawy O T x .

suhteellisen pienille kuville — se anti-aliasoi kuvan ja
prosessointi kestda pitempaan. Kun kuva viedaan isompana (>6x),on sen efekti minimaalinen.
Expresii toimii jossain vektorimuotoisen ja bittikarttamuotoisen grafiikan valimaastossa ja voit vieda jopa 12K

x 12K pikselin vedoksia.

2. Kopioi ja liitda: Kun Expresiin paaikkuna on auki, voit painaa [Ctrl]+[C] kopioidaksesi kdyttiksen leikepoydalle.

Paina sitten ([Ctrl]+[V]) liittddksesi toiseen ohjelmaan muokkausta varten



JARJESTELMAASETUKSET

. . . . v SYStem
Jarjestelmatila ol o ~
o o (Lvoma -] [ =]
Expresiin tdysversiossa voit vaihtaa jirjestelmatilaa
Ohjelmavalikko>Jarjestelma> Lisdasetukset>Jirjestelmitila kohdasta. 8 o) |
€ Ful

Valittavat tilat ovat Kevyt, Kevyt+ ja Tays.

Kevyttilassa on kdytdssa vain yksi taso ja yksi musteen vari. Kevyt+ on kuten kevyttila, mutta kdytdssa on
kaksi tasoa. Tdystilassa kayttajalla on kaikki varit kdaytossaan. Kevyttilat on tarkoitettu
vanhemmille/hitaammille koneille, jotta kdyttaja pystyy edes luonnostelemaan tai luomaan kalligrafia

kuvioita.

Kayttajatlla ¥ System
e 2 [w. |

Kayttajatila on oletuksena Normaali. Lisdasetustilassa edistyneemmat [Lnoma ] [ = |
.'. Marmal

Achrance**

kayttajat saavat enemman vaihtoehtoja kayttoéliittymaan.

Kumoa/Tee uudelleen

Kumoa ja Tee uudelleen toimintojen maaraan vaikuttaa kuinka paljon
videomuistia koneella on. nvidian GPU:ta kayttavilla voimme lukea
———————— Free:529 MB|‘7

muistin maaran ja asettaa nama tasot automaattisesti. Muiden
valmistajien kohdalla joutuu kdyttdja itse nostamaan tasoa, jos tietadd, ettd muistia on riittavasti. Oletuksena

maara on 5. Jos asetat luvun liian korkeaksi on siveltimen vedon alussa viive.




Jarjestelmainfo & Diagnostiikka

Napsauta Ohjelmavalikko>Jarjestelma>Info>Informaatio,

ja ‘Jarjestelmdinfo’ ikkuna aukeaa. lkkunassa on vélilehti
myos diagnostiikalle, jossa voit tarkistaa piirtopdydan ja

G-sensorin lukemat jos nama sy6tot ovat saatavilla.

EXTRA LAITTEISTOTUKI

Kynan kallistus

Expresii sallii dlylaitteen kayton ulkoisena
kallistus-sensorina, jos oma piirtopdydan
kynasi ei tule kallistusta. Toistaiseksi vain
Android laitteita tuetaan. Suorita laitteellasi

applikaatio ‘IMU+GPS Stream’ jonka saa Google

Play:sta. Syota tietokoneesi IP-osoite, 16ydat sen

Expresiistd, kun valitset Alylaitteen kallistuksen

sensoriksi. Jata portiksi oletusluku ‘5555’ ja valitse

¥
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App Menu (=] B
j L= L
» Actions
» View
» Windows
» Input
v System

Stylus (WACOM Tablet)
Pressure

Tilt 25
Button 1 Eraser 7

L

G-Sensor (not available)

@ website [ FanPage B Forum BB Feedback

5 e

e

¥ O 100% 08:18

g @
Preférences

Edit Target IP Adress

192.168.2.103

Edit Target Port

5555

Input Edit Sensor Update Frequency

(£ smartDevi | [ setvertical |
(4] stylus Tilt

My IP:
192.168.2.103

<«

‘UDP Stream’. Napsauta lopuksi ‘Switch Stream’ painiketta. Lisaa tietoa ja demo

video taalla.

Pinnan kallistus

® JUDP Stream

UDP & SD-Card
Stream

Switch Stream

SD-Card Stream

Run in
Background

Sen lisaksi, etta voit kayttaa sisddnrakennettua G-sensoria Windows tabletillasi, voit kdyttaa myos ulkoisia

laitteita hallitaksesi pinnan kallistusta:



https://play.google.com/store/apps/details?id=de.lorenz_fenster.sensorstreamgps&hl=en
http://www.expresii.com/blog/using-smart-device-as-stylus-tilt-controller

Peliohjain. Jos ohjaimesi on varustettu kallistus-sensorilla (esim. Sony ety = B

PS3. Yhdistdmisohjeet), voit kayttaa sitakin. Valitse joko ’Peliohjaimen : & / o | =
sauva’ tai 'Peliohjaimen kallistus’ kun painat kuvaketta Kosteus/Kallistus- » Format
¥ Muoisture / Tilt

paneelin oikeassa alalaidassa.

21 Mo Controller
» & Controller Stick l}
» o W Controller Tilt
= l* Droidmote
:g 5-Sensor
Android laite. Suurin osa Android laitteista on varustettu WO 2 @ 100% 12:03
kiihtyvyysantureilla ja voit kdyttaa sita pinnan kallistukseen applikaation & Settings
Droidmote kautta. Suorita heidédn Palvelinohjelmansa koneella johon Disable Sound O
. » . e X Disable sound on scroll and drag
Expresii on asennettuna. Ota kiihtyvyysanturi kdytt66n Droitmoten
asetukset sivulla (katso kuvaa oikealla). Expresiissé valitse ‘Droidmote’ debnMoie s
For android games without mouse D
. . ) support. You need to select a Touch
vaihtoehto Kosteus/Kallistus-paneelissa. Profile
GAMEPAD

able Accelerometer
Enable accelerometer on Gamepad.
an only be used on games with

epad support

- Loppu -


https://www.google.com/search?q=using%20ps3%20ps4%20controller%20on%20windows%20&rct=j#q=using+ps3+controller+on+windows
https://play.google.com/store/apps/details?id=org.videomap.droidmoteclient&hl=en
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